Lab 3: Comsol Multiphysics for Equation-based Modeling and Groundwater Flow Computations

(Comsol 5.2a)

1 Introduction

In this case study we will use Comsol Multiphysics, a highly flexible general-purpose finite-element package: it can be used as an engineering tool for predefined modeling situations, but also as a numerical solver for partial differential equations, for which the user explicitly defines the equations or the associated variational form. Comsol can either be run from its own Graphical User Interface (GUI) or can be set up to interface with Matlab. In this course, we will only use the GUI.

For engineering use, there are ready-made “canned solutions,” such as computing the stress in a loaded wrench or the sound field in a muffler. The user may use these as a starting point and modify the geometry (it is also possible to import CAD models), associated parameter values (Young’s modulus, speed of sound, …), and boundary conditions in order to obtain the required result.

Using Comsol in this way, the user does not need to know exactly what equations, what variational form, or what elements that Comsol uses. (All this information is available under the hood within the GUI, however). In order to see the available predefined solutions, select Application Libraries under the File menu, click on the ➪ to the left of COMSOL Multiphysics, and a list appears containing the predefined models from Acoustics, Chemical Engineering, etc. Additional “modules” (CFD, Structural Mechanics…) containing even more predefined models are sold separately. Your available version may contains the Structural Mechanics Module in addition to the basic COMSOL Multiphysics folder.

Within this course, however, we will not use the ready-made solutions, but an “expert mode”, which allows precise specifications of the equations, the boundary conditions, and the elements. There are three conceptually different ways in the “expert mode” to specify equations and boundary conditions, namely through the coefficient form, the general form, or the weak form. In the coefficient form, the problem is specified through settings of individual coefficients in a quite general system of partial differential equations and associated boundary conditions. In the general form, the equation is specified through the definition of a flux function in a conservation-law formulation of the equation. The weak form is the most general and precise way to specify the equations in a finite-element context, and it is this formulation we will use below. In the weak form, the equation is specified by specifying the integrands that occur when writing the equation in a variational form, as in expression (2) below.

Remark 1 (regarding terminology). In the lectures of this course, we use the term “variational form” for equations like (2) below, whereas Comsol uses the term “weak form” for the same object. Note also that the use of the term “weak form” does not in any way indicate that this form is inferior! The situation is in fact the opposite; the “weak form” is the most general and precise way to specify the equation to be used in a finite-element context, since all finite-element methods operate through approximations of a chosen weak (or variational) form.

This lab consists of two parts. The first part, Getting Familiar with Comsol Multiphysics, is an introduction to the use of the software. It is useful to work through this part even if you have some previous experience with Comsol. In particular, the way we will use the software (through specification of the variational form) is likely new to you. The second part, Modeling of Steady Groundwater Flow in an Aquifer, is the “sharp” part and constitutes the basis for the lab examination.

1The reason for the terminology is that the solution to a variational problem constitutes a weak (or generalized) solution to the partial differential equation; that is, a solution that may contain less smoothness than the form of the partial differential equation would initially suggest.
2 Part 1: Getting Familiar with Comsol Muliphysics

When using Comsol Multiphysics, as well as any other finite-element software, there are conceptually five consecutive steps that need to be taken for each problem:

1. geometry definition,
2. meshing,
3. problem specification,
4. solution,
5. post processing and visualization.

2.1 Geometry definition.

In order to learn how to carry out parameterized solid geometry modeling, work through the printout Creating a 2D Geometry Model from the Comsol Multiphysics Modeling Guide. Note: Once you have created the 2D geometry as described in the above document, save it to file, since you will need it for the steps below!

2.2 Meshing

In this course, we will only need to create simple so-called unstructured triangular meshes (which Comsol calls "Free triangular meshes"). In the Model Builder, click on **Mesh 1**, and the **Mesh** page appears in the Settings tab. On the **Mesh** tab, select **User-controlled mesh** under **Sequence type**. Then click on the © symbol to the left of **Mesh 1** in the Model Builder to open up more options under **Mesh 1**. Click on **Size**, which opens the **Size** page in the Settings tab. On the **Size** page, under **Calibrate for**, select **Fluid dynamics**. Then click again on the **Build All** button on the Settings tab in order to build the mesh, which then will be shown in the Graphics window. Play around with the options on the **Size** page (Maximum element size e.g.) to see what happens with the mesh. When you have changed any parameters, you need to press the **Build All** button again.

**Remark 2.** If you would like to learn more about meshing (or about any other issue in the following), select **Documentation** in the **Help** menu, which brings up a web page with the available documentation. For instance, there is a Meshing section in the Comsol Multiphysics Reference Manual.

2.3 Problem specification

We will work with the following boundary-value problem for Laplace's equation:

\[ -\Delta u = 0 \quad \text{in } \Omega, \]

\[ u = u_D \quad \text{on } \Gamma_D \]

\[ \frac{\partial u}{\partial n} = 0 \quad \text{on } \Gamma_i \]

\[ \frac{\partial u}{\partial n} + \alpha u = \alpha u_a \quad \text{on } \Gamma_o \]

(1)

on the domain \( \Omega \) that you constructed in § 2.1 (figure 1).

Problem (1) constitute a simple model for steady (that is, thermal equilibrium has been reached) heat conduction in a metal object occupying domain \( \Omega \), where \( u \) is the temperature. We assume that boundary \( \Gamma_D \) is held at a fixed, given temperature \( u_D \), that boundary \( \Gamma_i \) is thermally insulated, and that boundary \( \Gamma_o \) is facing air at a fixed, given temperature \( u_a \). The value of \( \alpha \) is related to the so-called heat transfer coefficient for the interface between the solid material and air.
Task 1. By applying integration by parts, show that boundary-value problem (1) can be written in the following variational form:

Find \( u \in V_{ud} \) such that

\[
\int_{\Omega} \nabla v \cdot \nabla u \, dV + \alpha \int_{\Gamma_0} vu \, ds = \alpha \int_{\Gamma_0} vu_a \, ds \quad \forall v \in V_0,
\]

where

\[
V_{ud} = \left\{ v \mid \int_{\Omega} |\nabla v|^2 \, dV < \infty, v = u_D \text{ on } \Gamma_D \right\},
\]

\[
V_0 = \left\{ v \mid \int_{\Omega} |\nabla v|^2 \, dV < \infty, v = 0 \text{ on } \Gamma_D \right\}.
\]

Recall the steps to be taken when deriving the variational form:

1. Multiply the PDE with a test function that satisfies the "test function rule" and integrate over the domain.
2. Apply Green's formula (integration by parts).
3. Use the boundary conditions and the conditions of the test functions on the boundary to reduce the expression.

When using the weak form in Comsol, the integrands in the variational form (2) are specified in symbolic form. More precisely, the expression inside the domain integral is written in one place, and the expression inside the boundary integral over \( \Gamma_0 \) is written in another place. For instance, the integrand inside the integral over \( \Omega \) can be written in components as

\[
\nabla v \cdot \nabla u = v_x u_x + v_y u_y,
\]

where the subscripts denote differentiation. In Comsol Multiphysics, expression (4) is written

\[
test(ux)*ux + test(uy)*uy
\]

where \( test(u) \) denotes a test function associated with the unknown \( u \) (which is denoted \( v \) in variational form (2)), and a trailing \( x \) or \( y \) denotes differentiation with respect to the coordinate \( x \) or \( y \).

Implementation in Comsol Multiphysics

We assume that the geometry and a mesh has been created as specified in § 2.1 and 2.2. The steps below guides you through the remaining steps in order to numerically solve variational problem (2).

1. In the Model Builder (the leftmost tab in the Comsol GUI), right-click on Component 1 and select Add Physics.

2. In the Add Physics page that appears to the right in the GUI, select Mathematics > PDE Interfaces > Weak Form PDE and click Add to Component at the top of the window. This action will add a leaf Weak Form PDE under Component 1 in the Model Builder and associates the default dependent variable name \( u \) with a variational (weak) form. You may change the default name for the dependent variable by clicking on Dependent Variables in the middle Settings tab and edit in the box labeled Dependent variables. (You can also choose more than one field variable here. For the Maxwell equations written as a first-order system, for instance, you would choose 6 variables in three space dimensions, corresponding to the 3+3 components of the electric and magnetic fields).
3. In order to define values for parameters $\alpha$, $u_D$, and $u_a$, used in the boundary conditions, in the Model Builder, click on Parameters under Global Definitions. Enter values of the variables $\alpha$, $u_D$, and $u_a$, in the table on the Parameters page in the Settings tab. We assume that the device attached to $\Gamma_D$ holds a temperature of 100°C, and that the room temperature is 20°C. Moreover, we assume that the heat transfer coefficient is such that $\alpha = 1$. Thus,

$$u_D = 100, \quad u_a = 20, \quad \alpha = 1. \quad (6)$$

4. Click on the $\rightarrow$ sign to the left of Weak Form PDE in the Model Builder to open more selections (in case those are not already open), then select Weak Form PDE 1.

5. In the Weak Form PDE page that then appear in the Settings tab, replace the default expression in the field weak with expression (5). This action defines the contribution of the integrals over $\Omega$ to variational form (2).

6. Right-click on Weak Form PDE in the Model Builder and select More $>$ Weak Contribution. (There are two instances of More appearing when you right-click; select the second one, the one below Periodic conditions).

7. Click on the Weak Contribution 1 that will appear under Weak Form PDE in the Model Builder. A page labeled Weak Contribution will appear in the Settings tab. On the Weak Contribution page, make sure that Manual is selected among the Selection options. Click on the boundary segments (there are quite a few) that correspond to boundary $\Gamma_o$ and add them to the box labeled Active (can be done by clicking on the $+$ sign e.g.). Enter the text $\alpha*test(u)*(u-ua)$ in the field labeled Weak Contribution. This action defines the contribution of the integrals over $\Gamma_o$ to variational form (2).

Note: you can have arbitrarily many leafs Weak Form PDE 1, Weak Form PDE 2...(for volume integrals) and Weak Contribution 1, Weak Contribution 2... (for boundary integrals) under the root Weak Form PDE. In the end, all these contributions will be added together to form a total variational form that will be of the type $\langle expression \rangle = 0$. Be therefore careful with the signs of the various terms! If one term is originally on the left side of the equal sign in the variational form and another term on the right side, they must have opposite signs in the weak contribution specifications in Comsol!

8. Right-click on Weak Form PDE in the Model Builder and select Dirichlet Boundary Condition. A page Dirichlet Boundary Condition will appear in the Settings tab. On the Dirichlet Boundary Condition page, make sure that Manual is selected among the Selection options. Click on the boundary segments that correspond to boundary $\Gamma_D$ and add...
them to the box labeled Selection: (can be done by clicking on the + sign e.g.). Add $uD$ in the box below the text Prescribed value of $u$.

Note: You do not need to do anything to set the boundary condition at $\Gamma_i$. Why?

9. Right-click the root object in the Model Builder (the root object has the same name as the file in which the model is saved) and choose Add Study. In the Add Study tab that appears to the right, select Stationary, and click on Add Study at the top of the tab.

10. Right-click on Study 1 in the Model Builder, select Compute, wait for the solution to be computed. (Alternatively, you can click on the equal sign at the top of the window or in the middle tab).

11. When the solution is computed, a color surface plot will appear in the graphics window, in which the colors visualizes the temperature distribution in the domain. Check so that the temperatures appear reasonable with respect to what can be expected from the boundary conditions on $\Gamma_D$ and $\Gamma_o$.

Fourier's law is a constitutive relation for heat conduction that models the heat conduction in materials, such as metals. Fourier's law is analogous to Darcy's law for porous-media flows or Ohm's law in electromagnetism and states that the heat flux vector $q$ is proportional to the negative gradient of the temperature,

$$q = -\kappa \nabla u,$$  \hfill (7)

where $\kappa > 0$ is the material's thermoconductivity. Expression (7) tells us that the heat energy will flow in the same direction as negative temperature gradients, that is, heat flows from high temperature to low temperature. If the thermoconductivity has the same value at each point in the material, it is said to be homogeneous. A scalar thermoconductivity characterizes an isotropic material; that is, the heat conducting properties is the same in each direction.

Task 2.

1. Here we will visualize how the heat flows in $\Omega$. Right-click Results > 2D Plot Group 1 in the Model Builder and select Arrow Surface.

2. In the Arrow Surface page that appears on the Settings tab, replace the default expressions in the fields labeled x component and y component with the ones obtained from expression (7). (Assume here that $\kappa = 1$). After entering the expressions, click on the Plot button. The small arrows that then show up in the graphics window indicates the direction of the heat flux, and if the Arrow length option is set to Proportional, also its local magnitude. Play around with the options for arrow plots, for instance the number of points for the vectors and the color and size. Try also to change Arrow length option to Logarithmic or Normalized, which can be useful in order to clearer see the direction of the arrows. Make sure that the plot you obtain seems reasonable in terms of the direction you expect the heat to flow.

3. Another way of visualizing the heat flux field is through streamlines. The streamlines associated with the $q$ field are curves through the domain that are such that their tangent at each point coincides with the $q$ vectors and such that the heat flow is always constant between two consecutive curves. The latter property means that the heat flow is more intense the denser the streamlines are. Plot streamlines of the $q$ field by right-clicking on Results > 2D Plot Group 1 in the Model Builder and selecting Streamline. In the Streamline page that appears in the Settings tab, replace the default expressions in fields labeled x component and y component with the ones obtained from expression (7). (Again, you may assume that $\kappa = 1$). Choose also Magnitude controlled instead of the default option under Streamline Positioning > Positioning: Then the density of the streamlines will indicate the magnitude of flow, just as they should. Also here play around with the options, such as the number of streamlines. (You may...
want to increase the number from the default value). It can be easier to see the streamlines by
disabling the arrow plots: right-click on Results > 2D Plot Group 1 > Arrow Surface
1 and choose Disable.

4. Compute solutions for $\alpha = 0, 0.2, 0.5, 1, 100, 1000$. Observe how the solution depends on $\alpha$.
What happens for a very large value of $\alpha$? Why?

3 Part II: Modeling of Steady Groundwater Flow in an Aquifer

An aquifer (sv. akvifär) is an underground region that hosts significant amounts of ground water
in materials such as gravel (sv. grus), sand, or clay. Aquifers are important sources of fresh water.

Figure 2 shows a vertical cross section of an underground region with a simple shape. The pale
rectangular area in the middle is made up of fine sand with homogeneous hydraulic conductivity
and porosity. The dark area to the left and below the sandy rectangular area consists of an imper-
vious (sv. ogenomträngligt) material such as solid rock. The region of sand borders to the upper
right to a concrete structure that also is impervious and to the lower right to a lake. The sand is
recharged with water (rain) from above, and water can also flow across the boundary between the
aquifer and the lake.

We assume that there is a steady rain of $r \text{ m/s}$ from above, and that the water level in the lake
is constant. The rain and the lake water will wet the sand. Since the rain is steady and the water
level in the lake is constant, the conditions underground will eventually reach steady state. We
may then divide the rectangular sandy region into an upper unsaturated zone (lightly tinted in
figure 3) and a lower saturated zone (darkly tinted in figure 3). In the saturated zone, all available
 pores in the sand is filled with water, but not so in the unsaturated zone.

The interface between the saturated and unsaturated zone is called the water table (sv. grund-
vattenyta). (Despite its name, the water table is not in general a horizontal surface, as illustrated
in figure 3!) Our task is to compute the shape of the water table and the flow pattern within the
saturated zone at steady state. The flow patterns can be particularly important to know for envi-
nmental studies, since pollutants will be transported along with the groundwater flow.

We will at once simplify the situation and assume planar symmetry, that is, that the vertical
cross section illustrated in figure 3 extends for a large distance (infinitely) in the direction perpen-
dicular to the plane. This means that we may model in the two space dimensions of the plane ($x$
and $y$).

Within the lower saturated layer, it is pressure differences and gravity that are the dominating
mechanisms that drive the flow of water. For groundwater flow analysis, it is standard practice
to measure pressure not in Pa but in meters of water level. That is, the pore gauge pressure (sv.
övertryck) is $p$ (in meters of water level) at a point $x = (x, y)$ in the aquifer if this pressure would
be able to sustain a column of water with the height $p$ meters. The pore gauge pressure is measured
relative to the atmospheric pressure, that is, $p = 0$ means that the pore gauge pressure equals the
atmospheric pressure. The condition $p = 0$ holds at the water table.

A good model for the slow flow of water that takes place in the saturated layer is Darcy's law,
which for groundwater flow takes the form

$$u = -\kappa \nabla (p + y),$$

where $u = (u, v)$ (in m/s) is the apparent velocity (explained below), $\kappa > 0$ (in m/s) is the hy-
draulic conductivity of the material, $p$ (in m water level) is the pore gauge pressure, and $y$ the ver-
tical level (from an arbitrary but fixed datum, that is, some chosen horizontal coordinate plane).
Moreover, $\nabla = (\partial/\partial x, \partial/\partial y)$ is the gradient operator. If $\kappa$ is constant, the conductivity is said to
be homogeneous, otherwise it is heterogeneous.
The form (8) of Darcy’s law requires that the fluid flow is creepingly slow and that the hydraulic conductivity of the material in the aquifer is isotropic, that is, that its conductivity property is the same in every direction. Expression (8) can be generalized to the case of anisotropic media, such as when the ground has a layered structure, for which the conductivity is different in the directions parallel and perpendicular to the layers. In such cases, \( \kappa \) will not be a scalar but a symmetric matrix with positive eigenvalues. The eigenvalues yields the conductivities in the directions of corresponding eigenvectors.

On the micro level, water is sipping through the pores in the sand in a complicated manner. In order to capture large-scale effects, however, it is not important to know the precise micro-level velocity field. The apparent velocity \( u(x) \) expresses an average or “effective” velocity field, where the average is taken over a region around point \( x \), a region that is small in comparison with the global dimension but much larger than the pore size. Thus, if \( \hat{n} \, dS \) is a directed surface element (\( \hat{n} \) is the surface unit normal), the flux of water in m/s through the surface element will be \( \hat{n} \cdot u \, dS \), and if \( S \) is a surface inside the saturated region and \( \hat{n} \) a unit vector field on the surface, the net flux \( Q \) of water (in m\(^3\)/s) through the surface will be

\[
Q = \int_S \hat{n} \cdot u \, dS.
\]  

Again, the apparent velocity \( u \) is not the real velocity of the fluid on the micro scale, but a quantity that indicates average effects. In particular, it is a quantity that through expression (9) can be used to calculate the flux of water through surfaces.

Note also the minus sign in Darcy’s law (8). Assume, for instance, that the pressure is increasing in the positive \( x \) coordinate direction, that is, that \( \partial p / \partial x > 0 \). The pressure increase in the positive \( x \) direction will force the flow of water in the opposite, negative \( x \) coordinate direction. Moreover, recall that \( y \) is the vertical level, so \(- \nabla y = (0, -1, 0)\), which means that Darcy’s law (8) tells us, reasonably, that gravity forces the water in the direction of the gravitational force.

**Question 1.** Assume that there is no flow of water (apparent velocity zero) in a saturated aquifer. What will the pore gauge pressure be?

---

2 More precisely, relation (8) holds for small so-called Reynolds numbers. The Reynolds number of a flow case expresses the quotient between inertial and viscous forces. The Reynolds number is usually small for groundwater flow since the forces on the water in the pores of the medium is dominated by adhesive and capillary effects.

3 Or, more precisely, a symmetric second-order tensor.
By introducing the pressure head (sv. trycknivå)

\[ h = p + y, \]  

(10)

Darcy’s law (8) takes the simple form

\[ u = -\kappa \nabla h, \]  

(11)

which is the form which we will use from now on; in particular, the pressure head \( h \) will be the dependent variable in the boundary value problem to be implemented in Comsol.

Darcy’s law (11) contains two unknowns, the pressure head and the apparent velocity. The two unknowns require two equations, so we need another equation to close the system. That equation comes from the conservation of mass. At the pressures considered here, water can be regarded as an incompressible fluid. Let \( V \) be an arbitrary connected region inside the saturated region (a control volume) and let \( S \) be the boundary surface of \( V \). Since the medium is completely saturated, the water in \( V \) has nowhere to go except through the boundary \( S \); the pores are completely filled with water and the water cannot be compressed. Thus, “what comes in must go out”: the net influx of water must be exactly balanced by the net outflux at each point in time. The net flux \( Q \) of water through \( S \) is given by expression (9), so since \( Q = 0 \), expression (9) together with the divergence theorem (also called Gauss’ theorem) yields

\[ 0 = \int_S \hat{n} \cdot u \, dS = \text{[the divergence theorem]} = \int_V \nabla \cdot u \, dV, \]  

(12)

where \( \nabla \cdot u = \partial u/\partial x + \partial v/\partial y \) is the divergence of the velocity field \( u \). Since equation (12) holds for any control volume in the saturated region we conclude that

\[ \nabla \cdot u = 0 \]  

(13)

at every point in the saturated region, that is, the velocity field is divergence free. Equation (13) is called the incompressibility condition and holds in general for all velocity fields associated with incompressible fluids such as water or air at low speeds.

Together, Darcy’s law (11) and the incompressibility condition (13) implies that the pressure head \( h \) inside the saturated region \( \Omega \) satisfies equation

\[ -\nabla \cdot (\kappa \nabla h) = 0, \quad \text{in } \Omega. \]  

(14)

To solve the partial differential equation (14), we need to supply it with suitable boundary conditions. We divide the boundary of the saturated region \( \Omega \) into three parts, \( \Gamma_i, \Gamma_r, \) and \( \Gamma_l \) (figure 4). There is no flow through impervious boundaries, so \( \hat{n} \cdot u = 0 \) at each point on \( \Gamma_i \), which by Darcy’s law (11) implies that

\[ \kappa \frac{\partial h}{\partial n} = 0 \quad \text{on } \Gamma_i. \]  

(15)

We assume that there is a constant supply of \( r \) m/s rain from above (Göteborg?). The water is transported through the unsaturated region through gravity and capillary forces. In steady state, this supply penetrates through the boundary \( \Gamma_r \), which means that \( \hat{n} \cdot u = -r \) on \( \Gamma_r \). (The minus sign is because \( \Gamma_r \)’s outward-directed normal points upward but a positive \( r \) means downward-directed supply.) Together with by Darcy’s law (11),we find that

\[ \kappa \frac{\partial h}{\partial n} = r \quad \text{on } \Gamma_r. \]  

(16)
Figure 4. Definition of the parts of the boundary to the saturated region $\Omega$. The impervious $\Gamma_i$ (solid black), the recharge $\Gamma_r$ (dotted red), and the lake interface $\Gamma_l$ (dashed blue). Note that $\Gamma_i$ consists of two disconnected parts that borders to the rock and to the concrete structure, respectively. The datum, that is, the horizontal coordinate plane $y = 0$ is indicated, and $y_l$ is the lake water level.

In the lake, the pressure at vertical level $y$ is simply $y_l - y$, the height of the column of water above level $y$. At the boundary $\Gamma_i$, the pressure will attain the value of the pressure in the lake at this depth, thus $p = y_l - y$, which, by the pressure head definition (10) means that

$$h = y_l \quad \text{on } \Gamma_i.$$  \hfill (17)

To summarize, the boundary value problem for the pressure in the saturated region $\Omega$ is given by equations (14), (15), (16), and (17), that is,

$$-\nabla \cdot (\kappa \nabla h) = 0 \quad \text{in } \Omega,$$

$$\kappa \frac{\partial h}{\partial n} = 0 \quad \text{on } \Gamma_i,$$

$$\kappa \frac{\partial h}{\partial n} = r \quad \text{on } \Gamma_r,$$

$$h = y_l \quad \text{on } \Gamma_l.$$  \hfill (18)

**Task 3.** Derive the variational form associated with boundary-value problem (18). You may not assume that $\kappa$ is constant!

*Hint.* Use a slightly generalized Green’s identity. Recall the product rule

$$\nabla \cdot (v \ w) = v \nabla \cdot w + \nabla v \cdot w,$$  \hfill (19)

choose $w = \kappa \nabla h$, integrate and use the divergence theorem to obtain a Green’s identity suitable for the present problem.

### 3.1 Calculating the Water Table Level

Figure 5 illustrates the saturated region that will be used for computations. The saturated region consists of one part filled with sand and one part filled with clay; the hydraulic conductivities of these materials are $\kappa_s$ and $\kappa_c$, respectively. The shape of the water table is defined by linear interpolation of the points $x_i = (x_i, y_i), i = 0, ..., I$. The horizontal locations of these points are $x_i = 50 \cdot i / I$ m, $i = 0, ..., I$, but the vertical elevations $y_i$ are unknown, and the purpose of
Figure 5. The saturated region with the shape of the water table parameterized by points $x_0, \ldots, x_5$ (not drawn to scale). The lighter region consists of sand (conductivity $\kappa_s$) and the darker region of clay (conductivity $\kappa_c$). The boundaries $\Gamma_r$, $\Gamma_l$, and $\Gamma_i$ are marked in red, blue, and black, respectively. Note that $\Gamma_i$ consists of two disconnected parts.

The exercise is to estimate these. In figure 5, $I = 5$, but you are free to choose more points if you like!

In § 2 above, we constructed the geometry using solid modeling; that is, the geometry was defined through set operations on solid primitives like disks (circles) and rectangles. A conceptually different way to proceed is through surface modeling. In the present 2D case, "surface modeling" means that we define a solid by specifying a closed curve that will constitute the solid’s boundary. For the present case, surface modeling may be more convenient to use than solid modeling.

**Geometry definition using surface modeling**

1. Click on **New** in the **File** menu or launch Comsol in order to open the **Model Wizard**.
2. Select 2D on the Select Space Dimension page, Weak Form PDE on the Select Physics page, Stationary on the Select Study Page, and press the **Done** button.

   [Next, we will parameterize the locations of the points $x_i = (x_i, y_i)$, $i = 0, \ldots, I$.]

3. In the **Model Builder**, right-click **Global Definitions** and select **Parameters**.
4. In the field **Name**, write $x_0$, and in the field **Expression**, write $0 [\text{m}]$. Continue similarly with parameters $x_1, \ldots, x_5$ (or whatever your last point is), that is, the $x$-coordinates $x_1, \ldots, x_5$, which for instance can have values according to figure 5. (If you use more than 6 points, you will of course need to specify a narrower spacing than the one in figure 5). Then define parameters $y_0, y_1, \ldots$, that is, the $y$-coordinates $y_0, y_1, \ldots$. These should represent a reasonable starting guess for the shape of the water table, for instance the horizontal shape $y_0 = y_1 = \cdots = 6 \text{ m}$.

   [Now we will construct domain $\Omega$.]

5. In the **Model Builder**, right-click **Geometry 1** and select **Polygon**.
6. In the Polygon page that appears in the **Settings** tab, there are two fields for $x$- and $y$-coordinates for the locations of corners in a polygon. Enter the numbers derived from figure 5 in comma-separated lists. That is, in the $x$ field, enter $0, x_0, x_1$, and so on. Similarly, in the $y$ field, enter $0, y_0, y_1$, and so on.

7. In the **Model Builder**, right-click again on **Geometry 1** and select **Polygon** to create a second polygon. This polygon should represent the clay region, tinted dark brown in figure 5.

---

\[1\] For 3D problem, we would instead specify a closed surface, and define the solid would as the interior of the surface.
8. Construct the union of the two domain by using the **Union** Boolean operation. Make sure that the **Keep Input Boundaries** option is active.

### Implementation

Now implement the variational form you derived in Task 1 above by following the steps in Lab 1, section Implementation in Comsol Multiphysics, making the appropriate changes in order to comply to the present equation. Use the following parameter values (define them in the Parameters page!):

\[
\begin{align*}
\kappa_s &= 5 \times 10^{-6} \text{ m/s} & \text{(hydraulic conductivity, fine sand)} \\
\kappa_c &= 1 \times 10^{-7} \text{ m/s} & \text{(hydraulic conductivity, clay)} \\
y_l &= 5 \text{ m} & \text{(lake water level)} \\
r &= 600 \text{ mm/year} \approx 1.9 \times 10^{-8} \text{ m/s} & \text{(rainfall)}
\end{align*}
\]

When following the steps above to construct the geometry, the computational domain will consist of two parts, corresponding to the region \( \Omega_s \) of sand and the region \( \Omega_c \) of clay. The most straightforward way to implement the current variational form is to define two leaves, **Weak Form PDE 1** and **Weak Form PDE 2**, under the root **Weak Form PDE (w)** in the Model Builder. The first one is automatically provided after completing the steps above, and a second one can be added manually, for instance by right-clicking **Weak Form PDE 1** and selecting **Duplicate**. The software will add the contribution from both Weak Forms (and boundary integrals from the boundary condition on \( \Gamma_r \) as well). In the Settings tabs for **Weak Form PDE 1** and **Weak Form PDE 2**, there is an option to choose the subdomain(s) over which the integration will be carried out, which means that we can use different integrals in different parts of the domain. In our case, we will use this facility to apply different conductivities in the subdomains. A limitation of the software is that the automatically provided first weak form (**Weak Form PDE 1**), needs to be an integral over all subdomains. Therefore, choose \( \kappa_c \) as conductivity for the first Weak Form. For the second Weak Form, de-select domain \( \Omega_c \), and use \( \kappa_s - \kappa_c \) as conductivity for that Weak Form. After summing these contribution, the correct conductivities will be associated with both subdomains.

3.1.1 Studies

Results that are of interest to visualize are arrows and streamlines of the apparent velocity field \( \mathbf{u} \), in order to see the water transport ways. Moreover, level curves of the pore gauge pressure \( p \), and plots of the pressure on \( \Gamma_r \) is useful to figure out the water table location. In particular, plotting arrows is a good debugging tool, in order to confirm that the water is flowing generally in the expected direction!

**Plotting level curves**

1. In the **Model Builder**, right-click on **Results > 2D Plot Group 1** and select **Contour**.
2. On the **Contour** page that then appear in the Settings tab, enter in the field **Expression**, the expression for the pore gauge pressure (see definition (10)). If you click the box labeled **Level labels**, you will see labels for the level curves.
3. Since the dimensions is quite extended in the horizontal direction, it may be difficult to clearly see the level curves. They will be more visible if the plot is scaled to a square format. To do so, select on **Component 1 > Definitions > View 1 > Axis** and choose option **Automatic** in **View scale**.

**Plotting pressure on \( \Gamma_r \)**

1. Right-click on **Results** in the **Model Builder** and select **1D Plot Group**
2. Right-click on Results > 1D Plot Group 3 and select Line Graph.

3. In the Line Graph page that will appear in the Settings tab, add the boundary segments corresponding to $\Gamma_r$.

4. Enter the expression for the pore gauge pressure (definition (10)) in the field labeled Expression.

5. Click on the $>$ to the left of x-Axis Data. In the drop-down menu Parameter that then appears, choose Expression (instead of the default Arc length) and write $x$ in the field Expression.

6. Click on the Plot button to see a plot of the pore gauge pressure on $\Gamma_r$ versus the $x$ coordinate.

As pointed out in the introduction, boundary $\Gamma_r$ represents a water table if the pore gauge pressure $p = 0$. Thus, the problem of finding the shape of the water table corresponds to finding locations for the points $x_i$ such that $p = 0$. However, when computing the solution associated with your initial guesses of elevations $y_0, \ldots, y_I$ and plotting the pressure on $\Gamma_r$, you will see that the pressure is not zero, unless you are extremely lucky with your initial guess of the elevations!

---

**Task 4.**

1. Modify the shape of $\Gamma_r$, as defined by parameters $y_i, i = 1, \ldots, I$, until $|p| \leq 6$ cm uniformly along $\Gamma_r$. 
